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**Attention** 

Read this resource material carefully and in its entirety before use, to ensure it is 
understood and used properly.  Failure to properly follow the instructions in the 
resource materials DPAM provides may result in damage to your equipment.  As a 
result, by using the resource materials, you are assuming the risks associated with 
modifying your equipment. DENSO holds no liability, implied or otherwise, for 
damage, injury or any legal responsibility incurred, directly or indirectly from the use 
of the resource materials, including any loss of data or damage to property which 
may occur by your use of the resource materials. The use of the resource materials 
are not recommended unless you have technical knowledge and functional 
experience with the equipment and related software. DENSO is unable to provide 
support, remote or otherwise, for the information included in the resource material, 
nor for the ancillary topics relating to the information included in the resource 
materials. Therefore, if you are not fully comfortable with it, we strongly recommend 
that you send your unit to one of our Regional Support Centers for repair.  The 
information contained in the resource materials are subject to change at the sole 
discretion of DPAM.
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 1.1    Overview of Replacing the COBOTTA Assembly 

 
  Receiving project data in failed COBOTTA 

 

• Connect PC to faulty COBOTTA. 

• Confirm and take note of the software  

• Receive all project data (program, variable data, parameter data, ect) from 
the COBOTTA. 

• Take note of the Software Version of the damaged COBOTTA. 
 
Caution- Project data may not be receivable depending on the failure mode, make 
sure to receive a backup project regularly. 
 
 
 

 Remove and replace the damaged COBOTTA 

 
• Turn the power switch to the COBOTTA OFF. 

• Disconnect the power supply from the COBOTTA. 

• Remove Estop Circuit from the COBOTTA. 

• Take note of and remove all other connection points to the COBOTTA. 

• Unbolt and remove the COBOTTA from the workstation. 
 
 
 

Sending Project Data to the new COBOTTA 
 

• Connect your PC to the new COBOTTA. 

• Confirm the software version of the new COBOTTA. 

• Send all project data (program, variable data, parameter data, ect.) to the 
COBOTTA. 

 
Caution- Software version number must be the same or higher than the failed 
COBOTTA. 
 
 
 
 
 

  Sending Parameter Data to the new COBOTTA 
 

• Send the parameter data to the COBOTTA. 

• Disconnect your PC from the COBOTTA. 
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1.2 Receiving the Project Data from the Failed COBOTTA Assembly 
 

 
Caution- Before you begin receiving the Project Data: 
 

• Turn off power to peripheral devices (equipment connected to the COBOTTA. 

• Disconnect all connectors on the COBOTTA (except power source) 

• WINCAPS III with Virtual TP must be installed on the PC.  

• Set your static IP address within your PC to match the COBOTTA. 
Example: COBOTTA IP 192.168.0.1   PC IP 192.168.0.2 

 
 

 
 
 
Step 1.  Connect your LAN (Cross) cable from your PC to the LAN Port of the COBOTTA 

 
 

 

 

 

 
 

 

Step 2.  Turn On the power switch to the COBOTTA. 
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Step 3.  Start the Virtual TP (RC8) 
 

• [START] → [All Program Data] → [DENSO ROBOTICS] →[Robot Tools]→ 
[Virtual TP]→ [Virtual TP (RC8)] 
 

 
 
 
Step 4.  Choose [Connect] 
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Step 5.  Enter the IP address of the COBOTTA and then choose [Connect]. 
 

*If you do not know the IP address of the COBOTTA, follow steps 6, 7 and 8 to 
reset the IP address to the default value of 192.168.0.1.   If you do know the IP 
address of the COBOTTA and successfully connect proceed to step 9. 

 

 
 
 
 

 
Step 6.  To reset the COBOTTA’s IP address to the default address of 192.168.0.1, Press 

and hold the IP reset button on the COBOTTA and turn the power switch of the 
COBOTTA from OFF to ON.  Hold the reset button for at least 3 seconds after 
powering ON.  
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Step 7.  Set the IP address and the subnet mask for the local area connection of the PC 

as follows: 
 

• IP Address:  192.168.0.2 

• Subnet mask:  255.255.255.0 
 

 

   
 
 
Step 8.  In the “Connection Confirmation” box select User Level [Maintainer] 
Next enter Password [5593589], then choose “OK”. 
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Step 9.  Choose [Skip] 
 

 
 
 

 
Step 10.  Choose [Motion Preparation] 
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Step 11.  Next confirm and take note of the version of software using Virtual TP 

screens below. 
 
 
 
 
 
 

• Choose [Setting] 
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• Choose [System Info] 

 
 
 
 
 
 
 

• Take note of the version of software.  
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Step 12.  Start WINCAPS III    *If unable to connect to the controller or functions of 

WINCAPS III are not displayed, update WINCAPS III to the latest version and then 
retry the procedure. 

 
 

 
 
 
 
 
 
 

Step 13.   Login to WINCAPS III as Programmer using Password 5593589. 
 

               
 
 
 
 
 
 
 



13 
Revision 1.0 DM Last Update 2/28/20 

  

Step 14.  Choose New Project in the File Menu. 
 

               
 
 
 
 
 
 
 
 
 
 
Step 15.  When the Welcome to New project wizard screen is displayed, choose Get 

information for creating a new project then choose Next. 
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Step 16.  Name and also choose the File Location for the backup project you are 

creating.  After the Name and Location are designated choose [Next]. 
 

 
 
 
 
 
Step 17.  When the Connect to the Controller screen appears, change the IP address to 

match your COBOTTA’s IP address then choose Next.  *The default IP address of 
the COBOTTA is 192.168.0.1 

 

 
 

Enter a Project Name and also choose a Location to save the file in. 
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Step 18.  When the Finish screen appears choose Finish. 
 

 
 
 
 
 
 
 
 
 
 
Step 19.  When the sending and the saving of the Project Data is complete the screen 

below appears. 
 



16 
Revision 1.0 DM Last Update 2/28/20 

  

 
 
 
 
 
 
 

1.3    Sending Project Data to the New COBOTTA Assembly 

 
Step 1.  If needed, reset the IP address of the New COBOTTA by turning on the power 

and then pressing and holding the IP Reset Button for at least 3 seconds.  This sets 
the COBOTTA’s IP address to the default setting of 192.168.0.1 

 

 
 

Step 2.  After the COBOTTA completes the boot up process, turn the power OFF on the 
COBOTTA. 
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Step 3.  Connect one end of a LAN (cross) cable to the LAN connection port of the 

COBOTTA and the other end to the LAN port of your PC. 
 

      
 

 
Step 4.   Turn ON the power to the COBOTTA. 
 

 
Step 5.  Set the IP address and Subnet Mask for the local area connection of your PC as 

below. 
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IP Address:  192.168.0.2 
Subnet Mask:  255.255.255.0 

 

 
 

 

 

 
Step 6.  Start the Virtual TP on your PC. 
 

 

 

 

 

 

 



19 
Revision 1.0 DM Last Update 2/28/20 

  

 

 
Step 7.  Choose Connect on the Virtual TP screen. 

 

     
 

 

 
Step 8.  Choose Connect on the next screen. 

 

 

     
 

 

 

 

 
 
Step 9.  At the “Connection Confirmation” box select User Level as Maintainer and for 

the Password enter 5593589 as the password. 
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Step 10.  Choose Skip on the next screen. 
 

 
 

 
Step 11.  Now choose Motion Preparation. 

 

 
 
 
 
Step 12.   Next confirm the Version of the Software.  Using the Virtual TP Cancel to the 

Main Screen then choose Setting. 
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Step 13.  Now choose [System Info]. 
 

 
 
 
 

 
 
Step 14.  Confirm the version of the software.  The Version must be the same version 

number or higher than the version noted in Step 11 of Receiving the Project Data 
from the (Damaged) COBOTTA.  

 
* If the version of the replacement COBOTTA is older than the damaged robot please 

view the ROM image updating procedure that can be found at: 
https://www.densorobotics.com/knowledge-base/cobotta-version-upgrade-function-

https://www.densorobotics.com/knowledge-base/cobotta-version-upgrade-function-procedure/
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procedure/ 
Do not continue until the ROM image of the New COBOTTA is the same version or 

higher than the original COBOTTA. 
 
 
 

 
 
 
 
If your COBOTTA has a camera please follow the steps 15-18 below, if not skip to Step 

19. 
 
Step 15.  From the Main Screen of the Virtual Teach Pendant choose Shift. 
 

 
 
 
 
 
 
 
Step 16.  Now choose Vision. 

https://www.densorobotics.com/knowledge-base/cobotta-version-upgrade-function-procedure/
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Step 17.  Next select Build-in Vision. 
 

 
 
 
 
 
 
 
 
Step 18.   Now choose Disconnect. 
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Step 19.  Press Cancel twice to return to the Main Screen of the Virtual Pendant. 
 
 

 
 
 
 
 
 
 
 

Step 20.  Using your Laptop start up WINCAPS III. 
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Step 21.  Login to WINCAPS III as User Level 1 Programmer, then enter password 
5593589. 

 

                  
 
 
 
 
Step 22.  Send the Backup Project Data from the Faulty COBOTTA to the New 

COBOTTA using WINCAPS III.    Choose Open Project in the File menu. 
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Step 23.   In the Open dialog box locate the Backup File that was taken from the failed 

COBOTTA. 
 

 
 
 
 
 
 
Step 24.  Once the Backup Project opens Choose Option in the Tool menu. 
 

 
 
 
 
 
 
 
 
 
 
 
 
Step 25.  Click on the [Communication] tab in the [Option setting] dialog box, only 

Enable the [Data send setting: Backup data] option, then choose [OK].   
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*Make sure you keep [Data send setting: CALSET data] and [Data send setting: 

COBOTTA camera Calibration data] to Disable. 
 
 
 
 

 
 
 
Step 26.  Now choose Transfer data in the Connect menu. 
 

 
 
 
 
 
Step 27.  In the Transfer Data dialog box, select all data for the WINCAPS III side, and 

then choose Send->.   *Click OK,  if  the message “Please stop built in vision 
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function when you send the data of OpenCV to the Controller.”  Appears when 
selecting data. 

 

              
 
 
 
Step 28.  Choose Yes when Data of the Controller will be updated, are you sure you 

want to send the data appears. 
 

   
 
 
 

 
 
Step 29.  Once the data has been sent, the window below will be displayed, choose 

[OK]. 
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Step 30.  Turn the power switch of the COBOTTA Off, wait at least 6 seconds then turn 

the power switch of the COBOTTA back On.   Project Data Sending is now finished. 
 
 

 
 
 

 
 
 
 
 
 

1.3 Sending Parameter Data to the New COBOTTA Assembly 

 
 
*If at any time you are unable to connect to the controller or functions of WINCAPS III 

are not displayed, update WINCAPS III to the latest version and then retry these 
procedures. 

 
Step 1.  Start the COBOTTA parameter tool. 
 

[START] → [All program data] → [DENSO ROBOTICS] → [WINCAPS III] → [Tools] → 

[COBOTTA Parameter Tool] 
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Step 2.    Choose Open Project in the File menu. 
 

    
 
 
 
Step 3.  Select the folder with the project data that was received from the failed 

COBOTTA as pictured below. 
 

 
 
 
 
 
 

Step 4.  Choose the file with the file extension .WPJ 
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Step 5.  At the Getting the current parameter settings screen choose [Cancel]. 
 

 
 
 
 
 

 
Step 6.  Choose Send Parameters in the Connect menu. 
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Step 7.  Enter 5594382 (default) as the risk assessor password and then choose Send.  

*If you have changed the default password to your own password, enter that 
password. 

 

 
 
 
 
 
 
 
 

Step 8.  Choose OK when the Safety Parameters Have Been Transferred screen appears. 
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Step 9.  Now choose Close. 
 

 
 
 

 
Step 10.  Turn the power switch of the COBOTTA to the Off position, wait at least 6 

seconds then turn the switch back On.    The Parameter Data Sending and this 
procedure is complete.  Finally, using WINCAPS III create a backup project of the 
new COBOTTA. 

 

 
 
 
*Note* If you have to move a Camera from the original COBOTTA to the New 

COBOTTA a Camera Calibration is necessary.  Please view the COBOTTA Camera 
Calibration Manual. 

 


